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C H A P T E R  1  

Introduction 

This guide provides information on how to start working in Parallels Management Console—a 
client application used to manage Parallels physical servers and virtual machines. 

In This Chapter 
About Parallels Management Console .................................................................................. 4 
About This Guide.................................................................................................................. 6 
Getting Help.......................................................................................................................... 7 
Feedback ............................................................................................................................... 8
 
 

About Parallels Management 
Console 

Parallels Management Console is a remote tool with a graphical user interface (GUI) for 
managing Parallels physical servers and virtual machines residing on them. This tool supports 
managing physical servers running the following Parallels products: 

 Parallels Server for Mac 
 Parallels Server Bare Metal 
 Parallels Server for Mac Bare Metal Edition 

Parallels Management Console uses a typical client-server architecture. 
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The client application with the graphical user interface is installed on a computer running one of 
the supported Linux, Mac, or Windows operating systems. For the full list of supported 
operating systems, see the Checking System Requirements subsection of the Getting Started 
With Parallels Management Console guide. Once the client application is up and running, it can 
connect to the Parallels Service software on a physical server. This software is automatically 
installed on the physical server when you install one of the aforementioned Parallels products. 
The client application can control multiple physical servers simultaneously (e.g. Physical Server 
#1 and Physical Server #2 as shown in the picture above). After the connection to the required 
physical server has been established, you can start managing this server and its virtual machines 
using the intuitive and comfortable GUI. 

Parallels Management Console Specifics 

When working with Parallels Management Console, pay attention to the following: 

 This guide uses the term Parallels Server Bare Metal to refer to both products: Parallels 
Server Bare Metal and Parallels Server for Mac Bare Metal Edition. 

 Some features described in this guide are specific for particular products and product 
versions (for example, only for Parallels Server 5 Bare Metal) and may be not available in 
your product. If a feature is available for a specific product only, we add a note to the place 
where this feature is described. 

 You can install the version of Parallels Management Console shipped with Parallels Server 
5 Bare Metal only on computers running Linux and Windows operating systems. 
Installation on Mac computers is not supported. 

 Some steps, option names, paths are different on Linux, Mac, and Windows computers. In 
this case, these differences are marked with the following icons: 

  for Windows specifics 

  for Linux specifics 

  for Mac specifics 
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About This Guide 
The Getting Started With Parallels Management Console guide provides information on 
installing and setting to work the Parallels Management Console application on your computer. 

The guide is aimed at anyone planning to use Parallels Management Console for managing 
Parallels physical servers and virtual machines. To follow the instructions in this guide, no more 
than basic Linux, Mac, or Windows administration skills are required. 

Definitions 

Parallels physical server or host computer: In this guide, these terms are used to refer to 
physical servers running Parallels Server for Mac, Parallels Server Bare Metal, or Parallels 
Server for Mac Bare Metal Edition. 

Client computer: In this guide, this term is used to refer to a remote Windows, Linux, or Mac 
physical computer with Parallels Management Console installed. 

Virtual Machine. In this guide, this term is used to refer to a virtualized PC environment in 
which an operating system can be installed and run just like in a physical computer. 

Guest operating system (guest OS): The term is used to refer to an operating system that is 
installed in a virtual machine. 
 

Organization of This Guide 
This guide is organized in the following way: 

 Chapter 1, Introduction, gives an overview of Parallels Management Console and this guide. 
 Chapter 2, Setting Parallels Management Console to Work, describes the requirements your 

computer must meet to successfully install Parallels Management Console on it. It also 
provides instructions on how to install this application and start working in it. 

 Chapter 3, Performing Basic Operations in Parallels Management Console, familiarizes you 
with the way to perform the main operations on your virtual machines using Parallels 
Management Console. 

 

Documentation Conventions 
Before you start using this guide, it is important to understand the documentation conventions 
used in it. 

The table below presents the existing formatting conventions. 

Formatting convention Type of Information Example 
Items you must select, such as 
menu options, command buttons, 
or items in a list. 

Go to the Resources tab.  

Special Bold 

 Titles of chapters, sections, and Read the Basic Administration chapter. 
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subsections. 

Italics Used to emphasize the 
importance of a point, to 
introduce a term or to designate 
a command-line placeholder, 
which is to be replaced with a 
real name or value. 

These are the so-called EZ templates. 

To destroy a Container, type vzctl 
destroy ctid. 

Monospace The names of commands, files, 
and directories. 

Use vzctl start to start a Container. 

Preformatted On-screen computer output in 
your command-line sessions; 
source code in XML, C++, or 
other programming languages. 

Saved parameters for Container 
101 

Monospace Bold What you type, as contrasted 
with on-screen computer output. 

# rpm –V virtuozzo-release 

Key+Key Key combinations for which the 
user must press and hold down 
one key and then press another. 

Ctrl+P, Alt+F4 

Besides the formatting conventions, you should also know about the document organization 
convention applied to Parallels documents: chapters in all guides are divided into sections, 
which, in their turn, are subdivided into subsections. For example, About This Guide is a section, 
and Documentation Conventions is a subsection. 
 

Getting Help 
In addition to this guide, you can refer to the following resources to get more information on 
Parallels Management Console: 

 Parallels Management Console User's Guide. This guide contains extensive information on 
configuring Parallels Management Console settings and using this application to manage 
Parallels physical servers and virtual machines hosted on them. To open the guide, choose 
Parallels Management Console Help from the Parallels Management Console Help menu. 

 Context-sensitive help. When working in Parallels Management Console, you can open a 
help page for the currently active window by pressing F1 on your keyboard. 

 Online documentation. All documentation for Parallels Management Console and other 
Parallels products, such as Parallels Server Bare Metal and Parallels Server for Mac, is also 
available online. 

 Parallels website (http://www.parallels.com/support/). Visit the Parallels Support web page 
containing product help files and the FAQ section. 

 Parallels Knowledge Base (http://kb.parallels.com/). This online resource comprises various 
articles about using Parallels Management Console and other Parallels products. 

 

 

http://www.parallels.com/support/
http://kb.parallels.com/
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Feedback 
If you spot a typo in this guide, or if you have an opinion about how to make this guide more 
helpful, you can share your comments and suggestions with us by completing the 
Documentation Feedback form on our website (http://www.parallels.com/en/support/usersdoc/). 

 

 
 

http://www.parallels.com/en/support/usersdoc/


 9 
 

 

C H A P T E R  2  

Setting Parallels Management Console to 
Work 

This chapter describes the requirements your computer must meet to successfully install 
Parallels Management Console on it. It also provides instructions on how to install this 
application and start working in it. 

In This Chapter 
Checking System Requirements ........................................................................................... 10 
Obtaining Parallels Management Console ............................................................................ 11 
Installing Parallels Management Console ............................................................................. 13 
Exploring Parallels Management Console Interface ............................................................. 17 
Connecting to a Server .......................................................................................................... 20 
Uninstalling Parallels Management Console ........................................................................ 22
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Checking System Requirements 
Parallels Management Console can be installed on any computer that meets the following 
requirements: 

Hardware Configuration 

 Intel-powered Mac with Core™ Duo or Core™ Solo processor or a PC with 700+ MHz 
Intel-compatible x86 or x64 processor 

 1 GB of RAM 
 100 MB of hard disk space for Parallels Management Console installation files 
 Ethernet or WiFi network adapter 

Compatible Operating Systems 

Ubuntu 10.10 (x86, x64) Windows 7 with and without Service 
Pack 1 (x86, x64) 

Ubuntu 10.4 (x86, x64) Windows Server 2003 R2 (x86, x64) 

Red Hat Enterprise Linux 6 (x86, x64) Windows Server 2003 Enterprise Edition 
with Service Pack 2 (x86, x64) 

Red Hat Enterprise Linux 5.5 and 5.6
(x86, x64) 

Windows Server 2008 R2 with Service 
Pack 1 (x64) 

Red Hat Enterprise Linux 4.8
(x86, x64) 

Windows XP with Service Pack 3 (x86, 
x64) 

CentOS 4.8 (x86, x64) Windows Vista with Service Pack 2 
(x86, x64) 

CentOS 5.5 and 5.6 (x86, x64) Mac OS X v10.5 Leopard or Server 
Leopard 

SUSE Linux Enterprise Server 10 with 
Service Pack 1 (x86, x64) 

Mac OS X v10.6 Snow Leopard or 
Server Snow Leopard 

SUSE 11 with Service Pack 1 (x86, x64)  

Note: The version of Parallels Management Console shipped with Parallels Server 5 Bare Metal 
can be installed only on computers running Linux and Windows operating systems. 
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Obtaining Parallels Management 
Console 

There are various ways to obtain Parallels Management Console: 

 If you install  Parallels Server for Mac, Parallels Management Console will be also installed 
on the Mac. You will be able to launch it from the Applications folder right after the 
Parallels Server for Mac installation. 

 If you need a separate Parallels Management Console installation file for Windows, Linux, 
or Mac, you can download it from the Parallels official website for free. Go to 
http://www.parallels.com/download/ and click one of the following Parallels products: 
Parallels Server for Mac or Parallels Server Bare Metal. The Parallels Management Console 
download links will be available in the Additional Downloads section of the displayed 
window. 

 If you installed Parallels Server Bare Metal on your physical server, follow these steps to 
obtain the Parallels Management Console installation file: 

1 Ensure that the Parallels server (i.e. the physical server running Parallels Server Bare Metal) 
can be accessed over the network. 

2 On a computer connected to the network, open your favorite browser, and type the IP 
address or hostname of the Parallels physical server. You will be presented with the 
following window. 
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3 Click the link corresponding to your system architecture: 

 For Windows. Click this link to download the Parallels Management Console installation 
file for installing on Windows computers. 

 For Linux. Click this link to download the Parallels Management Console installation file 
for installing on Linux computers. 

 For Mac. Click this link to download the Parallels Management Console installation file 
for installing on Mac computers. 

Note: The version of Parallels Management Console shipped with Parallels Server 5 Bare 
Metal can be installed only on computers running Linux and Windows operating systems. 

4 Download the file. 

5 If you plan to install Parallels Management Console on another computer, transfer the file to 
that computer. 

 

 



 Setting Parallels Management Console to Work 13 
 

Installing Parallels Management 
Console 

The process of installing Parallels Management Console differs depending on the operating 
system installed on your computer. 

Installing on Windows Computers 

To install Parallels Management Console on a computer running a Windows operating system: 

1 Locate the Parallels Management Console installation file, and double-click it to launch the 
Parallels Management Console Setup wizard. 

2 In the Welcome window, click Next. 
3 In the License Agreement window, carefully read the end user license agreement for 

Parallels products. To agree with the terms of the license agreement, select I accept the 
terms in the license agreement, and click Next. If you want to print the text of the license 
agreement for your records, click Print. 

Note: You must accept the license agreement to proceed with the installation. 

4 In the Destination Folder window, specify the folder where you want to install Parallels 
Management Console, and click Next. By default, Parallels Management Console is installed 
to C:\Program Files\Parallels\Parallels Management Console. 
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5 In the Ready to Install the Program window, click Install to start installing Parallels 
Management Console. You can view the installation progress in the Installing Parallels 
Management Console window. 

6 Once the installation is complete, click Finish to exit the wizard. 

Installing on Linux Computers 

To install Parallels Management Console on a computer running a Linux operating system: 

1 Locate the installation package, and execute the parallels-management-console-
5.0.XXXX.XXXXX.run file to launch the Parallels Management Console installer. You 
can also open a terminal and run this file in the terminal. 

2 Confirm your decision to install Parallels Management Console by clicking Run when 
prompted. 

Wait until the process of uncompressing Parallels Management Console is complete and the 
installer launches. 

3 In the Welcome window, select Next. 
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4 In the License Agreement window, carefully read the end user license agreement. To agree 
with the terms of the license agreement, select I accept the terms in the license agreement, 
and click Next. To print the text of the license agreement for your records, click Print. 

Note: You must accept the license agreement to proceed with the installation. 

5 In the Installation Completed window, click Exit to quit the Installer. 

By default, Parallels Management Console is installed into /usr/lib/parallels-
management-console. To launch Parallels Management Console, start a terminal, and 
execute pmc-standalone. 

Installing on Mac Computers 

To install Parallels Management Console on a computer running a Mac OS X operating system: 

Note: The version of Parallels Management Console shipped with Parallels Server 5 Bare Metal 
can be installed only on computers running Linux and Windows operating systems. 

1 Open the Parallels Management Console DMG package, and double-click Install. 
2 In the Welcome window, click Continue. 
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3 In the Important Information window, read the product Read Me file. Click Print to print the 
document or Save to save it for future reading. When finished, click Continue. 

4 In the Software License Agreement window, carefully read the license agreement. You can 
use the Print button to print the license agreement text or click the Save button to save it on 
your computer. When you are ready, click Continue. 

5 In the pop-up dialog, click Agree to agree with the terms and conditions of the license 
agreement. 

Note: You must accept the license agreement to proceed with the installation. 

6 In the Select a Destination window, select the hard disk where to install Parallels 
Management Console. 

7 Click Install to start the Parallels Management Console installation. 

8 Enter your password, when prompted, and click OK. The installation progress is displayed in 
the Installing Parallels Management Console window. 

9 Once the installation is complete, click Close to exit the installer. 

After the installation, you can launch Parallels Management Console from the Applications 
folder on your Mac. 
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Exploring Parallels Management 
Console Interface 

Parallels Management Console main window displays general information about the registered 
Parallels servers and their virtual machines. 

The main window consists of the following parts: the toolbar, the sidebar, the summary pane, 
and the status bar. 
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Toolbar 

Parallels Management Console toolbar has buttons for most frequently used commands: 

  Shut Down button. Use this button to turn off the virtual machine. 

  Suspend button. Use this button to put your virtual machine into sleep mode. For 
example, if you need to restart the Parallels server, you can temporarily suspend your virtual 
machines and easily resume them after the restart. 

  Pause button. Use this button to pause the virtual machine. Use this button when you 
need to instantly release the server resources used by this virtual machine to another virtual 
machine. 

Note: If you stop a paused virtual machine, you will not be able to continue working with it 
from the moment it was paused. To be able to stop the virtual machine and to save all the 
data in it, you should suspend it using the Suspend button. 

  Start button. Use this button to start the virtual machine if it is stopped, paused, or 
suspended. 

  Detach Console (Attach Console) button. Use this button to detach the virtual machine 
console to a new window or to attach it back to the main window. You may use this button 
to view the currently running virtual machines in separate windows. 

  Server level button. Use this button to quickly switch from the virtual machine 
summary pane to the summary pane of the server this virtual machine belongs to. 

You can easily add additional buttons to the toolbar: 

1 Right-click the toolbar, and choose Customize Toolbar. 
2 Drag the items you need to the toolbar. 

3 Click Done. 

Sidebar 

The sidebar displays the registered Parallels physical servers and all virtual machines, and 
virtual machines templates hosted on them. 

Summary Pane 

The summary pane displays the basic information about the server or the virtual machine 
currently selected in the sidebar. 

When a server is selected, the summary pane has three tabs: 

 Summary. Click this tab to view the general settings of the selected server, the list of virtual 
machines hosted on it, and the operations you can perform on the server. 

 Performance. Click this tab to view the current resources consumptions on the server. 
 Backup. Click this tab to view and manage the backups stored on the server. 
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When a virtual machine is selected, the summary pane has three tabs: 

 Summary. Click this tab to view the general settings of the selected virtual machine, its 
configuration, and the list of actions you can perform on this virtual machine. 

 Console. Click this tab to view the display of the virtual machine that is currently running. 
This tab is available only when the virtual machine is running. 

 Performance. Click this tab to view how much of the server resources the selected virtual 
machine is using. 

 Backup. Click this tab the view and manage the backups of the selected virtual machine. 

Status Bar 

The status bar becomes active, when you start a virtual machine. It displays the virtual machine 
devices icons when you click the Console tab or switch the virtual machine console to detached 
mode. You can easily connect or disconnect the devices using the icons on this bar: right-click 
the device icon and choose the necessary option from the shortcut menu. 
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Connecting to a Server 
Now that you have installed Parallels Management Console, you can connect to the physical 
server where Parallels Server Bare Metal is installed. Do the following: 

1 Launch Parallels Management Console: 

 On Mac OS X, open the /Applications/Parallels folder and launch the 
Parallels Management Console application. 

 On Windows, click Start > All Programs > Parallels > Parallels Management Console > 
Parallels Management Console. 

 On Linux, start a terminal and execute pmc-standalone. 

2 In the Parallels Management Console main window, click Connect to Parallels Server. 
3 In the Parallels Server Login dialog, specify the parameters to be used to log in to the 

physical server running Parallels Server Bare Metal: 

 In the Server list, type the IP address or hostname of the physical server. 

 In the User Name field, type root. You must use the root account to log in to the 
physical server. 

 In the Password field, type the password for the root user. Use the password you 
specified when installing Parallels Server Bare Metal on the physical server. 

If you want Parallels Management Console to remember your login and password, select the 
Save Password option. With this option selected, you do not need to specify the root 
credentials each time you connect to the server. 
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4 Click Add Server to establish connection to the physical server. 

After the server has been successfully registered in Parallels Management Console, it appears in 
the left menu of the Parallels Management Console main window. For further information on 
using Parallels Management Console to manage Parallels Server Bare Metal and virtual 
machines, refer to the Parallels Management Console User's Guide. 
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Uninstalling Parallels Management 
Console 

Use these procedures to remove Parallels Management Console from your computer. 

From Windows computers 

Parallels Management Console can be removed from a Windows computer like any other 
Windows application: 

1 From the Start menu, choose Control Panel, and then double-click Add or Remove Programs. 

2 Select Parallels Management Console, and click Remove. 

From Linux computers 

Parallels Management Console can be removed from a Linux computer like any other Linux 
application: 

Note: To remove Parallels Management Console, you must have the root privileges. 

1 Locate the Parallels Management Console installation package and execute the 
parallels-management-console-5.0.XXXX.XXXXX.run file to run the 
Parallels Management Console installation program. 

2 In the Welcome window, press Enter. 

3 Select Remove and press Enter. 

When Parallels Management Console is successfully uninstalled, press Enter to close the 
Parallels Management Console uninstaller. 

From Mac computers 

Parallels Management Console can be removed from a Mac computer like any other Mac 
application: 

1 Locate the Parallels Management Console icon. 

2 Right-lick the icon and choose Move to Trash. 
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C H A P T E R  3  

Performing Basic Operations in Parallels 
Management Console 

This chapter outlines the basic day-to-day operations that you are likely to perform with 
Parallels virtual machines in Parallels Management Console. 

In This Chapter 
Creating a Virtual Machine................................................................................................... 23 
Configuring a Virtual Machine ............................................................................................. 31 
Managing Virtual Machines.................................................................................................. 32 
Managing Virtual Machine Templates.................................................................................. 40
 
 

Creating a Virtual Machine 
Before you can start managing a virtual machine, you first need to create it. The process of 
creating a ready-to-use virtual machine includes these steps: 

1 Creating a virtual machine configuration. In this step, you choose and configure the virtual 
hardware for the virtual machine (disk drives, CD/DVD-ROMs, network cards, and so on). 

2 Installing a guest operating system. In this step, you choose and install the operating system 
(called the guest operating system or the guest OS) in the virtual machine: 

 To check the list of supported guest operating systems available for Parallels Server for 
Mac, see the Parallels Server for Mac User's Guide. 

 To check the list of supported guest operating systems available for Parallels Server 
Bare Metal, see the Parallels Server Bare Metal User's Guide. 

 To check the list of supported guest operating systems available for Parallels Server for 
Mac Bare Metal Edition, see the Parallels Server for Mac Bare Metal Edition User's 
Guide. 

3 Installing Parallels Tools. You are also recommended to install Parallels Tools in your 
virtual machine. They will make your work with the virtual machine more comfortable. For 
more information on Parallels Tools, see Installing Parallels Tools (p. 26). 

The following subsections describe all these steps in detail. 
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Creating a Virtual Machine Configuration 
Parallels Management Console allows you to create a virtual machine using one of the 
following modes: 

 Express. In this mode, Parallels Management Console does the following: 
a Creates a virtual machine with the configuration typical for the guest operating system 

you select for installing in this virtual machine. 

b Installs the selected guest OS in the newly created virtual machine. 

Using this mode, you can create virtual machines running Windows 7, Windows Vista, 
Windows XP, Windows Server 2003, Ubuntu, Fedora, Fedora Core 5, Red Hat Enterprise 
Linux. 

 Typical. In this mode, Parallels Management Console creates a virtual machine with the 
configuration typical for the operating system you select for installing in this virtual 
machine. But unlike the Express mode, the selected guest OS is not automatically installed 
in the newly created virtual machine. 

 Custom. In this mode, you control the whole process of creating the virtual machine: 
 First, you specify the parameters for creating the virtual machine configuration. 

 Second, you install the appropriate guest operating system in the virtual machine. 

The example below shows you how to create a virtual machine using the Typical mode in 
Parallels Management Console that is installed on a Windows computer. For information on 
creating virtual machines using the Express and Custom modes, see the Parallels Management 
Console User's Guide. 

To create a virtual machine in the Typical mode, do the following: 

1 Launch Parallels Management Console. 

2 If you have more than one physical server registered in Parallels Management Console, 
select the server where you want to host the new virtual machine. 

3 Start the New Virtual Machine wizard by doing one of the following: 

 Choose New Virtual Machine from the File menu. 

 Click New Virtual Machine on the server Summary tab. 

 Right-click the server icon in the sidebar and choose New Virtual Machine. 

4 In the Select Operating System Type and Version window, select the operating system you 
want to install in the virtual machine, and click Next. 
If you cannot find the necessary operating system in the list, select Other. 

5 In the Virtual Machine Type window, select Typical, and click Next. 
6 In the Name and Location window, type an arbitrary name for the virtual machine and 

specify the folder for storing its files. By default, all virtual machine files are placed to the 
following folders: 

 On Mac computers: 
/Users/Shared/Parallels/<Virtual_Machine_Name>/. 

 On servers running Parallels Server Bare Metal: /var/Parallels. 

When you are ready, click Next. 
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7 Once the virtual machine configuration is created, the Install Operating System window 
appears. 

 

In this window you can do the following: 

 Start installing the guest operating system in the newly created virtual machine: 

a Select the installation source in the Placement list. Choose Physical Server if 
your source installation files are located on the remote Parallels server; otherwise, 
choose Client Computer. 

b Specify the path to the source installation files. In the Source list, select a disc in the 
Physical CD/DVD-ROM Drive section if the operating system you plan to install is located 
on the disc inserted into the computer's CD/DVD drive. Click Choose an image file, and 
specify the path to a disc image if the operating system is located on a disc image. 

c Click Start to start the newly created virtual machine, and launch the guest operating 
system installation. 

 Quit the wizard without installing the guest operating system in the newly created 
virtual machine. To do this, click Done. 
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Installing a Guest Operating System 
Before you can start using the newly created virtual machine, you need to install a guest 
operating system in it (unless you are creating the virtual machine in the Express mode where 
the guest operating system is installed automatically without your interaction). The guest 
operating system installation starts automatically if you do the following: 

 Specify the path to the source installation files in the Prepare to Install Operating System 
window of the New Virtual Machine wizard, and click Start. 

 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 
dialog. In this dialog, click the Hardware tab, select CD/DVD 1 in the left pane, choose the 
installation source in the Source list, and click OK. After that, start the virtual machine. 

Note: You can install a guest operating system only from the CD/DVD-ROM 1 drive. 

You can also install a guest operating system using a PXE server. 

1 Make sure that the virtual machine is connected to the same network to which the PXE 
server belongs. 

2 Click the name of the virtual machine in the left pane of Parallels Management Console. 

3 Click Configure to open the Virtual Machine Configuration dialog. 

4 On the Hardware tab, click Boot Order. 
5 Move the Network Adapter item to the top of the boot sequence, and click OK. 

Note: The virtual machine will use the network adapter specified as Network Adapter 1 in 
this virtual machine configuration. 

6 Start the virtual machine. 

Once the installation program is launched, follow the on-screen instructions to install your guest 
operating system in the virtual machine. This procedure does not differ from installing 
Windows, Linux, or Mac on a standalone computer. 
 

Installing Parallels Tools 
Parallels Tools are a suite of special utilities that facilitate working with your virtual machines. 
With Parallels Tools, you can move the mouse seamlessly outside the guest OS window without 
pressing special key combinations, change the virtual machine's screen resolution by simply 
resizing its window, and synchronize your virtual machine's time and date settings with the time 
settings of the Parallels physical server. 

The process of installing Parallels Tools differs depending on the guest operating system 
installed in your virtual machine. The subsections below describe the mains steps for installing 
Parallels Tools in virtual machines running Windows, Linux, and Mac. For more information on 
Parallels Tools, see the Parallels Management Console User's Guide. 
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Installing Parallels Tools in Mac OS X 

To install Parallels Tools in a Mac guest OS X, do the following: 

1 Start the virtual machine, and log in to the guest OS. 

2 Choose the Install Parallels Tools option from the Virtual Machine menu. This will connect 
and mount the Parallels Tools ISO image file (prl-tools-mac.iso) to the first 
CD/DVD-ROM in the virtual machine configuration. 

Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools are 
supported by your guest operating system. For the full list of guest OSs that support 
Parallels Tools, refer to the Parallels Management Console User's Guide. 

3 In the displayed window, read the brief information about Parallels Tools, and click 
Continue. 

4 Open the mounted image, and double-click Install to start the installation. 

5 When prompted, enter your administrator credentials. 

6 In the Welcome window, click Continue. 

7 In the Select a Destination window, specify the location for storing Parallels Tools files, and 
click Continue. 

Note: If you have only one volume on your Mac, this step is omitted. 

8 In the Standard Install on "Macintosh HD" window, click Install (when prompted, type your 
password). 

9 Once the installation is complete, click Restart to exit the installer and restart the virtual 
machine. 

Troubleshooting 

If the Parallels Tools ISO image file was not automatically connected to the virtual machine's 
CD/DVD-ROM drive, you can connect it manually: 

1 Right-click the CD/DVD-ROM drive icon in the status bar (p. 17) of the virtual machine 
window, and select Configure. The CD/DVD pane of the Virtual Machine Configuration dialog 
opens. 

2 In the Source menu, select Choose an image file. 

3 In the displayed window, specify the Parallels Tools ISO image file location (by default, it 
is located in /Library/Parallels/Tools on your Mac or in 
/usr/share/parallels-server/tools on the server running Parallels Server 
Bare Metal or Parallels Server for Mac Bare Metal Edition) and click Open. 

4 Make sure the Connected option is selected and click OK. 

5 Go to Step 4 of the installation procedure described above and repeat the following steps. 
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Installing Parallels Tools in Windows 

To install Parallels Tools in a Windows guest operating system, do the following: 

Note: If you create a virtual machine using the Express Windows mode, Parallels Tools are 
installed automatically after the Windows guest OS installation. 

1 Start the virtual machine, and log in to the guest OS. 

2 Choose the Install Parallels Tools option from the Virtual Machine menu. This will connect 
the Parallels Tools ISO image (prl-tools-win.iso) to the virtual machine's CD/DVD-
ROM drive and start the Parallels Tools installer. 

Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools are 
supported by your guest operating system. For the full list of guest OSs that support 
Parallels Tools, refer to the Parallels Management Console User's Guide. 

3 In the Welcome window, click Install to install Parallels Tools. The installation also starts 
automatically after several seconds even if you do not click the Install button. 

4 When the installation is complete, click Reboot to exit the wizard and restart the virtual 
machine. If you do not click Reboot, the guest operating system will be rebooted 
automatically within a few seconds. 

Troubleshooting 

If the installation of Parallels Tools does not start automatically after performing the steps 
above, start it manually. To do this: 

1 Right-click the CD/DVD-ROM drive icon in the status bar of the virtual machine window 
and select Configure. The CD/DVD pane of the Virtual Machine Configuration dialog will 
open. 

2 In the Source menu, select Choose an image file. 

3 In the displayed window, specify the Parallels Tools ISO image file location (by default, it 
is located in /Library/Parallels/Tools on your Mac or in 
/usr/share/parallels-server/tools on the server running Parallels Server 
Bare Metal or Parallels Server for Mac Bare Metal Edition) and click Open. 

4 Make sure the Connected option is selected and click OK. 

5 In the guest operating system, open My Computer. 

6 Open the CD/DVD-ROM drive with the Parallels Tools ISO image connected. 

7 Locate the setup.exe file, and double-click it. The Welcome window will open. 

8 Click Install to install Parallels Tools. 

9 When the installation is complete, click Restart to exit the wizard and restart the virtual 
machine. 
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Installing Parallels Tools in Linux 

Before installing Parallels Tools in a Linux guest operating system, do the following: 

 Close all applications in the guest OS. 
 Disable the 3D-accelerated window manager, if you use any. 
 Make sure that you have the gcc package and the appropriate kernel-sources package 

installed. If these packages are not installed, you will see a warning message when installing 
Parallels Tools. The name of the kernel-sources package differs depending on the Linux 
guest OS. It can be called kernel-devel, kernel-headers, or something like this. 

Installing Parallels Tools in Modern Linux Distributions 

If your virtual machine is running one of the most recent versions of Linux OSs (e.g.Fedora 11), 
the Parallels Tools ISO image (prl-tools-lin.iso) will be automatically mounted after 
you connect the image to the CD/DVD-ROM drive. To install Parallels Tools, do the following: 

1 Start the virtual machine and log in to the guest OS. 

2 Choose Install Parallels Tools from the Virtual Machine menu. This will connect and mount 
the prl-tools-lin.iso image file to the virtual machine's CD/DVD-ROM drive. 

Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools are 
supported by your guest operating system. For the full list of guest OSs which support 
Parallels Tools, refer to the Parallels Management Console User's Guide. 

3 Start a terminal, and run the following command to gain the root privileges: 
su 

Note: To install Parallels Tools in a virtual machine, you must have the root privileges. 

4 Go to the CD/DVD-ROM directory: 
cd /media/cdrom/ 

Note: In some Linux operating systems, the mount point for the virtual CD/DVD-ROM 
drive may appear as /media/Parallels Tools. 

5 In the CD/DVD-ROM directory, execute the following command to launch Parallels Tools 
installation: 

./install 

6 Follow the instructions on the screen to complete the installation. 

7 When the installation of Parallels Tools is complete, restart the virtual machine. 

Installing Parallels Tools in other versions of Linux guest OSs 

To install Parallels Tools in older versions of Linux OSs, you have to mount the prl-tools-
lin.iso image file manually: 

1 Start the virtual machine. 

2 When the guest OS boots up, click the Virtual Machine menu, and choose Install Parallels 
Tools. 
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Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools are 
supported by your guest operating system. For the full list of guest OSs which support 
Parallels Tools, refer to the Parallels Management Console User's Guide. 

The prl-tools-lin.iso image file will be connected to the virtual machine's 
CD/DVD-ROM drive. 

3 Start a terminal in your Linux guest OS. Type the following command to gain the root 
privileges: 

su 

Note: To install Parallels Tools in a virtual machine, you must have the root privileges. 

4 Ensure that the Parallels Tools CD image is mounted by running the following command: 
mount | grep iso9660 

 If this command does not produce any output, proceed to Step 5. 

 If this command returns something like 
/dev/cdrom on /media/cdrom type iso9660 (ro,exec,nosuid,nodev,uid=0), 

skip Step 5, and proceed to Step 6. 

 If this command returns something like 
/dev/cdrom on /media/cdrom type iso9660 (ro,noexec,nosuid,nodev,uid=0) 

with the noexec option present in parentheses, unmount the disc using the following 
command, and then proceed to Step 5: 

umount /dev/cdrom 

5 To mount the Parallels Tools installation disc image, run this command: 
mount -o exec /dev/cdrom /media/cdrom 

Note: /dev/cdrom is the virtual machine's CD/DVD-ROM drive and /media/cdrom is 
the mount point for this device. In some Linux operating systems, the virtual CD/DVD-
ROM drive may appear as /dev/hdb and the mount point may be /mnt/cdrom. Some 
Linux OSs do not have the CD/DVD-ROM mount point. In this case, you should create a 
mount point manually. 

6 When the installation disc image is mounted, go to the CD/DVD-ROM directory: 
cd /media/cdrom/ 

7 Execute the following command to launch the Parallels Tools installation: 
./install 

8 Follow the instructions on the screen to complete the installation. 

9 When the installation of Parallels Tools is complete, restart the virtual machine. 
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Configuring a Virtual Machine 
To edit the settings of a virtual machine and the devices it uses, you can use the Virtual Machine 
Configuration dialog. To open this dialog, do one of the following, choose Configure from the 
Virtual Machine menu. 

 

The Virtual Machine Configuration dialog contains three tabs: 

 General. This tab allows you to configure the basic virtual machines settings: the virtual 
machine name, the number of processors to be available to the virtual machine, and the 
amount of memory that the virtual machine can use. You can also type any additional 
information about the virtual machine in the Notes text box. 

 Options. This tab allows you to configure various settings related to the virtual machine 
operation. For example, you can adjust the virtual machine startup and shutdown settings, 
edit the Parallels Tools parameters, or configure access rights to the virtual machine. 

 Hardware. This tab allows you to configure the current settings of the devices existing in the 
virtual machine: video cards, floppy disk and CD/DVD-ROM drives, hard disk drives, 
network adapters, and so on. You can also add new devices to the virtual machine and delete 
existing ones. 

For detailed information on configuring the settings of a virtual machine, see the Parallels 
Management Console User's Guide. 
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Managing Virtual Machines 
This section provides information on the basic day-to-day operations you are likely to perform 
on your virtual machines: 

 starting and stopping a virtual machine (p. 32) 
 pausing and suspending a virtual machine (p. 33) 
 switching view modes (p. 34) 
 cloning a virtual machine (p. 36) 
 adding an existing virtual machine to Parallels Management Console 
 deleting a virtual machine (p. 38) 

 

Starting and Stopping a Virtual Machine 
To start a virtual machine, do one of the following: 

 Click the Start  button in the toolbar. 
 Choose Start from the Virtual Machine menu. 
 Right-click the virtual machine in the sidebar and choose Start from the shortcut menu. 
 Click Start in the Operations section of the virtual machine Summary tab. 

To stop a virtual machine, use the standard shut down procedure that is typical for its guest 
operating system. For example, you can click Start > Turn Off Computer > Turn Off to shut down 
a virtual machine running Windows XP. If you cannot shut down the guest OS from inside the 
virtual machine, use one of these ways: 

 Click the Stop  button in the toolbar. 
 Choose Stop from the Virtual Machine menu. 
 Right-click the virtual machine in the sidebar, and choose Stop from the shortcut menu. 
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Pausing and Suspending a Virtual Machine 
If you do not want to spend much time on stopping your virtual machine, you can either pause 
or suspend it. Pausing a virtual machine can be useful if you need to instantly release resources 
the virtual machine uses. Suspending a virtual machine is convenient when you need to freeze 
and save the processes in the virtual machine for a long period of time. 

To pause a virtual machine, do one of the following: 

 click the Pause button  in the toolbar 
 choose Pause from the Virtual Machine menu 
 right-click the virtual machine in the sidebar and choose Pause from the shortcut menu 
 click Pause in the Operations section of the virtual machine Summary tab 

To suspend a virtual machine, do one of the following: 

 click the Suspend button  in the toolbar 
 choose Suspend from the Virtual Machine menu 
 right-click the virtual machine icon in the sidebar and choose Suspend from the shortcut 

menu 
 click Suspend in the Operations section of the virtual machine Summary tab 

To resume a suspended or paused virtual machine, do one of the following: 

 click the Resume button  in the toolbar 
 choose Resume from the Virtual Machine menu 
 right-click the virtual machine in the sidebar and choose Resume from the shortcut menu 
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Switching View Modes 
Parallels Management Console provides several view modes to make your work with virtual 
machines easier and more efficient. 

 Window. This is the default view mode. Using this mode, you can see the virtual machine 
screen in the Parallels Management Console window or in a detached console window. 

 Full Screen. Using this mode, you can expand the virtual machine screen up to the size of 
your computer screen. 

 Detached Console. Using this mode, you can view the virtual machine screen in a separate 
window. 

For switching between these modes, use the menu commands or toolbar buttons. 

Switching to the Full Screen mode 

You can run a guest operating system in the full screen mode when the guest OS window 
occupies the whole screen of your computer and the Parallels Management Console controls are 
hidden.  

To switch to the Full Screen mode, do one of the following: 

 click the Full Screen button  in the toolbar 
 choose Full Screen from the View menu 
 use the hot key combination (Ctrl+Alt+Enter by default) 

To exit the Full Screen mode and return to the Window mode, press the hot key combination 
that coincides with the key combination for switching to the Full Screen mode (Ctrl+Alt+Enter 
by default). 

Switching to the Detached Console mode 

If you have a number of virtual machines, you can run each of them in its own window by 
detaching their windows from the main window of Parallels Management Console. 

To detach the virtual machine window, do one of the following: 

 click the Detach Console button  in the toolbar 
 choose Detach Console from the View menu 

To attach the virtual machine window back, do one of the following: 

 close the detached window 

 click the Attach Console button  in the toolbar 
 choose Attach Console from the View menu 

Locking the guest OS screen resolution 

The virtual machine screen resolution can be changed in the following situations: 
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 When you adjust the guest OS display settings. 
 When you resize the virtual machine window (this feature works only when Parallels Tools 

are installed in your virtual machine). 
 When you run an application that automatically changes the screen resolution of your guest 

OS. 

This behavior of the virtual machine window can be irritating. To freeze the virtual machine 
screen resolution, use the Lock Window option available from the View menu. When the Lock 
Window option is enabled, the virtual machine screen resolution can be changed by adjusting the 
guest OS display settings only. 
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Cloning a Virtual Machine 
If you need to create an exact copy of a virtual machine, to back it up, or for some other 
purposes, use Clone Virtual Machine Assistant (or Clone Virtual Machine Wizard if Parallels 
Management Console is installed on a Windows- or Linux-based computer). 

Using Clone Virtual Machine Assistant, you can clone a virtual machine, its virtual hard disks, 
and configuration file. 

The cloned virtual machine has the same configuration as the original virtual machine. If a 
device in the original machine was connected to an external resource, this device in the cloned 
virtual machine will be connected to the same external resource. 

Notes: 

1. If the original virtual machine has a printer or serial port connected to an output file, the 
virtual machine clone will have empty output files. 

2. If a network adapter is enabled in the original configuration, a new MAC address will be 
generated for the virtual machine clone. 

To clone a virtual machine: 

1 Make sure that the virtual machine you want to clone is not running. 

2 Select the virtual machine in the Parallels Management Console sidebar. 

3 Start Clone Virtual Machine Wizard by doing one of the following: 

 choosing Clone from the Virtual Machine menu 

 clicking Clone in the Operations section of the virtual machine Summary tab 

4 In the Name and Location window, type the name of the virtual machine clone and specify 
the folder for storing its files. You can use the Choose button to locate the folder. 

By default, the files of the virtual machine clone will be placed to the following folder: 

  on Mac OS X: 
/Users/Shared/Parallels/<Virtual_Machine_Name>/ 

  on servers running Parallels Server Bare Metal: 
/var/parallels/<Virtual_Machine_Name> 

  on servers running Parallels Server for Mac Bare Metal Edition: 
/var/parallels/<Virtual_Machine_Name> 
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 To make the Windows security identifier (SID) of the cloned virtual machine different 
from that of the initial virtual machine, select Change Windows SID. It will help you to avoid 
possible security problems. 

Click Clone to start cloning the virtual machine. 

5 When the operation is complete, click Done in the Cloning Finished window. 

The clone of the virtual machine will appear in the Parallels Management Console sidebar. 
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Deleting a Virtual Machine 
If you do not need some of your virtual machines anymore, you can either delete them or 
temporarily remove from the virtual machines list: 

 Deleting a virtual machine means permanently erasing its files from the Parallels server. 

Note: Make sure you transferred all the necessary data from the virtual machine before 
deleting it: this operation is irreversible. All the virtual machine data will be lost. 

 Removing a virtual machine from the list displayed in the Parallels Management Console 
window means just removing the virtual machine from the list without removing the virtual 
machine files from the Parallels physical server. 

You can delete a virtual machine using Delete Virtual Machine Assistant (or Delete Virtual 
Machine Wizard if Parallels Management Console is installed on a Windows- or Linux-based 
physical computer). By default, the assistant removes all the files stored in the virtual machine 
folder, including the configuration file, virtual hard disk files, floppy disk image files, and 
output files of serial and printer ports. 

To delete a virtual machine or remove it form the list: 

1 Launch Parallels Management Console. 

2 In the sidebar, select the virtual machine you want to delete or remove from the list. 

3 Start Delete Virtual Machine Assistant by doing one of the following: 

 choose Remove from the File menu 

 click Remove in the Operations section of the virtual machine Summary tab 

Note: Before deleting a virtual machine, make sure that the virtual machine is stopped. 

4 In the Delete Options window, select the operation you want to perform on the virtual 
machine. 

 To delete the virtual machine, select Delete, and click Next. 
 To remove the virtual machine from the list, select Remove from list and click Remove. 
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5 If you chose to delete the virtual machine, you would be presented with the Files Selection 
window. This window displays all the files that belong to the virtual machine. 

 

Choose the virtual machine files you want to delete, and click Delete. 

6 Once the operation is complete, click Done to exit the assistant. 
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Managing Virtual Machine 
Templates 

If you need to create several virtual machines with a similar configuration, you can create a 
virtual machine template and use it as the basis for creating new virtual machines. 

You can use one of the following ways to create a virtual machine template: 

 Convert an existing virtual machine into a virtual machine template. In this case, the virtual 
machine will be moved from the virtual machines list to the templates list once the 
conversion is complete. It means that the virtual machine will be available as a template 
only (i.e. you will not be able to run it). 

 Clone an existing virtual machine to a virtual machine template. By cloning a virtual 
machine, you make its exact copy and can use it to create virtual machines with the same 
configuration. 
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Creating a Virtual Machine Template 
To convert an existing virtual machine into a template: 

1 Choose the virtual machine you want to convert into a template by clicking its icon in the 
sidebar. 

2 Choose Convert to Template from the Virtual Machine menu or right-click the virtual machine 
icon in the sidebar, and choose Convert to Template from the shortcut menu. 

Once the conversion is complete, the virtual machine is moved to the Templates list. 

To clone a virtual machine to a template: 

1 Launch Parallels Management Console. 

2 In the sidebar, select the virtual machine you want to clone. 

3 Start Create Virtual Machine Template Wizard by doing one of the following: 

 Choosing Clone to Template from the Virtual Machine menu. 

 Right-clicking the virtual machine in the sidebar, and choosing Clone to Template form 
the shortcut menu. 

4 In the Create Virtual Machine Template Wizard Introduction window, click Next. To skip 
this window next time you start the wizard, select Always skip introduction. 

5 In the Name and Location window, specify the name and location for the virtual machine 
template, and click Clone. You can use the Choose button to change the location. 

By default, the virtual machine template files are placed to the following folders: 

 On Mac OS X: 
/Users/Shared/Parallels/<Virtual_Machine_Template_Name> 

 On severs running Parallels Server Bare Metal: 
/var/parallels/<Virtual_Machine_Template_Name> 

 On severs running Parallels Server for Mac Bare Metal Edition: 
/var/parallels/<Virtual_Machine_Template_Name> 
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6 In the Creation Finished window, click Done to quit the wizard. 
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Deploying a Virtual Machine Template 
The virtual machine template cannot be run as a virtual machine. To be able to run it as a virtual 
machine, you should create a virtual machine that will have the same configuration the template 
does. 

There are two ways of creating a virtual machine from a template: 

 convert the template to a virtual machine 
 deploy the template to a new virtual machine 

If you convert a virtual machine template into a virtual machine, the template is moved from the 
Templates list to the virtual machines list. 

If you deploy a virtual machine template to a virtual machine, Deploy Virtual Machine 
Template Assistant (or Deploy Virtual Machine Template Wizard if Parallels Management 
Console is installed on a Windows- or Linux-based physical computer) creates a new virtual 
machine, but the template is not removed from the Templates list. 

To convert a virtual machine template into a virtual machine, select this template in the sidebar 
and do one of the following: 

 choose Convert to Virtual Machine from the File menu 

 right-click the template's icon and choose Convert to Virtual Machine from the context 
menu 

 click Convert to Virtual Machine in the Operations section of the template's Summary tab 

The virtual machine template will be moved from the Templates list to the virtual machines 
list. 

To deploy a virtual machine template to a new virtual machine: 

1 In the sidebar, select the virtual machine template you want to be deployed to a new virtual 
machine. 

2 Start Deploy Virtual Machine Template Assistant (or Deploy Virtual Machine Template 
Wizard if Parallels Management Console is installed on a Windows- or Linux-based 
physical computer) by doing one of the following: 

 choosing Deploy to Virtual Machine from the File menu 

 right-clicking the template's icon and choose Deploy to Virtual Machine from the context 
menu 

 clicking Deploy to Virtual Machine in the Operations section of the template's Summary 
tab 

3 In the Name and Location window, specify the name and location for the virtual machine. 
You can use the Choose button to change the location. 

By default, the virtual machine files are placed to the following folder: 

  On Mac OS X: 
/Users/Shared/Parallels/<Virtual_Machine_Template_Name> 

  On severs running Parallels Server Bare Metal: 
/var/parallels/<Virtual_Machine_Template_Name> 
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  On severs running Parallels Server for Mac Bare Metal Edition: 
/var/parallels/<Virtual_Machine_Template_Name> 

 

 To make the virtual machine Windows security identifier (SID) different from that of 
the virtual machine on which the template is based, select Change Windows SID. It will help 
you to avoid possible security problems. 

Click Deploy to start deploying the template to a new virtual machine. 

4 In the Deployment Finished window, click Done to close the wizard. 
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